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Landsat 5 – Not Ready to Quit Yet 

In the early morning hours of August 13, 2009, Landsat 5 experienced an attitude anomaly characterized by 
extreme gyro rates. The spacecraft proceeded to tumble out of control for some time until the Flight Operations 
Team (FOT) was able to stabilize the satellite attitude (positioning).   

After evaluations of the spacecraft, image acquisitions began again on August 14, with successful downlinks to 
the Landsat Ground Station (LGS) in Sioux Falls, SD.  Engineers evaluated the data and deemed images collected 
on August 14 as non-nominal due to cooler-than-normal temperatures associated with the primary focal plane of 
the instrument. Scenes from August 14, 2009 will not be available for download.  

Evaluation of this anomaly was considered compete on August 17, 2009.  All data collected at LGS beginning 
Saturday, August 15, 2009, are currently available for order or immediate download (http://glovis.usgs.gov or 
http://earthexplorer.usgs.gov).  

 



Page 2 of 6   9/9/2009 

Landsat Scenes Top One Million Downloads 
Over one million Landsat scenes have been downloaded from the USGS Earth Resource Observation and 
Science (EROS) Center since October 2008, when the Landsat archive was opened to user access at no charge. 
Free Landsat data enables non-restricted analysis of the earth’s surface for years to come.  

The official USGS Press Release can be found at 
http://www.usgs.gov/newsroom/article.asp?ID=2293&from=rss_home. 

Landsat scenes are available from the Global Visualization Viewer (http://glovis.usgs.gov)  or EarthExplorer 
http://earthexplorer.usgs.gov).  

 

LDCM News – The LDCM Operational Land Imager (OLI) Instrument Overview 
Just as the Landsat Data Continuity Mission (LDCM) will continue to expand the record of Earth observations, 
the instrument onboard Landsat 8 will supply enhanced data, with the addition of deep blue and cirrus bands on 
the Operational Land Imager (OLI).  Slight modifications have been made to the other bands that closely 
resemble the existing Enhanced Thematic Mapper Plus (ETM+) sensor specifications.  
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Landsat Free Archive – How Landsat Data are Being Used  
Statistics as of August 31, 2009 
 

 
 

Meetings & Conferences 

The Landsat Science Team Meeting was held June 22 – 24, 2009 at the Rochester Institute of Technology (RIT) 
for Imaging Science, in Rochester, New York.  Working Group discussions, Landsat Updates and other related 
items were reported.   The agenda and links to all presentations are located at 
http://landsat.usgs.gov/science_june2009MeetingAgenda.php.  
 
 

Tips & Tricks – Viewing a Gap-mask File in Photoshop 
 
Gap-mask files contain data values of (0=no data and 1=populated data), and when converted to brightness and 
first imported into Photoshop, will appear black.  This is because Photoshop uses data value numbers, whereas 
remote sensing imaging software typically uses Digital Number (DN) values of 0 and 255 to create a black and 
white display.  
 

Photoshop’s Equalize tool sorts pixel values within an image so the lowest value represents black and the 
highest value represents white.  To Equalize an image, select Image Adjustments  Equalize from the main 
menu. The file will then appear correctly. 



Page 4 of 6   9/9/2009 

Landsat Science Team Spotlight – Dr. Lazaros Oreopoulos 
 

 
 
Dr. Lazaros Oreopoulos began his career at NASA Goddard Space Flight Center in 1997.  He is a research 
physical scientist, with interests in atmospheric radiation and cloud modeling.  Cloud detection and avoidance 
are the primary focus points of his research as a member on the Landsat Science Team.   
 
He provides advice on cloud masking issues as well as the handling of cloud scores, forecasts, and 
climatologies by the next generation Long Term Acquisition Plan. He also attempts to simulate reflectance of the 
new OLI cirrus bands for different atmospheric, surface, and cloud configuration scenarios. 
 
Working with scenes that other scientists find of limited value, Oreopoulos’s interest in the three-dimensional 
effects of cloud cover leads him to study how these effects can be detected using power spectrum analysis of 
TM and ETM+ reflectance.  He also developed cloud retrieval techniques that minimize the effects.  
 
Recent publications relating to cloud detection and studies include 
 
• Sotiropoulou, R.-E. P., N. Meskhidze, J. Kouatchou, B. Das, L. Oreopoulos, J. M. Rodriguez, and A. Nenes, 

2009: Aerosol - cloud interactions in the NASA GMI: Model development and indirect forcing assessments. 
Atmos. Chem. Phys. (Submitted) 

 
• Oreopoulos, L., S. Platnick, G. Hong, P. Yang, and R. F. Cahalan, 2009: The shortwave radiative forcing bias 

of liquid and ice clouds from MODIS observations. Atmos. Chem. Phys. Disc. 9, 10337-10366. [Abstract] [Full 
Text (PDF)] 

 
For more information on his scientific interests, see http://climate.gsfc.nasa.gov/~lazaros/. 
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EROS Authors in Recent Publications 
 
Reeves, M.C., Ryan, K.C., Rollins, M.G., and Thompson, T.G., 2009, Spatial fuel data products of the LANDFIRE 
Project:  International Journal of Wildland Fire, v. 18, no. 3, p. 250-267.   
http://dx.doi.org/10.1071/WF08086 
 
Rollins, M.G., 2009, LANDFIRE: a nationally consistent vegetation, wildland fire, and fuel assessment:  
International Journal of Wildland Fire, v. 18, no. 3, p. 235-249. 
http://dx.doi.org/10.1071/WF08088 
 
Vogelmann, J.E., Tolk, B., and Zhu, Z., in press, Monitoring forest changes in the southwestern United States 
using multitemporal Landsat data:  Remote Sensing of Environment.   
http://dx.doi.org/10.1016/j.rse.2009.04.014 
 
Chen, X., Liu, S., Zhu, Z., Vogelmann, J., Li, Z., and Ohlen, D., in press, Estimating aboveground forest biomass 
carbon and fire consumption in the U.S. Utah High Plateaus using data from the Forest Inventory and Analysis 
Program, Landsat, and LANDFIRE:  Ecological Indicators.   
http://dx.doi.org/10.1016/j.ecolind.2009.03.013 
 
Zhao, S., Liu, S., Yin, R., Li, Z., Deng, Y., Tan, K., Deng, X., Rothstein, D., and Qi, J., in press, Quantifying 
terrestrial ecosystem carbon dynamics in the Jinsha Watershed, Upper Yangtze, China from 1975 to 2000:  
Environmental Management.   
http://dx.doi.org/10.1007/s00267-009-9285-9 
 
Beighley, R.E., Eggert, K.G., Dunne, T., He, Y., Gummadi, V., and Verdin, K.L., 2009, Simulating hydrologic and 
hydraulic processes throughout the Amazon River Basin:  Hydrological Processes, v. 23, no. 8, p. 1221-1235.   
http://dx.doi.org/10.1002/hyp.7252 
 
Huang, C., Goward, S.N., Masek, J.G., Gao, F., Vermote, E.F., Thomas, N., Schleeweis, K., Kennedy, R.E., 
Zhu, Z., Eidenshink, J.C., and Townshend, J.R.G., 2009, Development of time series stacks of Landsat images 
for reconstructing forest disturbance history:  International Journal of Digital Earth, v. 2, no. 3, p. 195-218. 
http://dx.doi.org/10.1080/17538940902801614 
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Landsat Images of Interest – The Vanishing Aral Sea  
 
The Aral Sea, located in Kazakhstan and Uzbekistan in central Asia, was once one of the largest inland bodies of 
salty reservoirs in the world and the second largest sea in Asia. Over the last 30 years, the Sea has diminished in 
capacity dramatically, as shown in these images captured by the Landsat series of satellites. A major factor 
causing the shrinkage is the drawing off by upstream feeder streams for crop irrigation. As the sea diminishes, 
noticeable changes in climate conditions and increasing sandstorms are affecting the area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A poster can be viewed and downloaded from the Landsat Gallery.  
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View Printable Version - .pdf 
(http://landsat.usgs.gov/documents/about_LU_Vol_3_Issue_3.pdf 586 
KB) 
 
 
Using the Landsat Archive 
 
Since opening the Landsat archive earlier this year, more than 500,000 Landsat scenes 
have been downloaded at no charge.  The availability of the Landsat archive allows 
opportunities for people to apply the data to more research projects, and has 
prompted other Landsat archives to remove the costs to some of their data holdings, 
such as: 
 
• Conservation efforts in Sumatra Island, Indonesia: Developing maps on 

deforestation in one province in Sumatra to show the impacts on biodiversity and 
global climate:  
http://www.worldwildlife.org/who/media/press/2008/WWFPresitem7596.html 
 

• Creation of large area land cover maps using chain classification:  “...USGS' 
decision to provide free access to all Landsat data holdings offers opportunities 
for large area land cover classifications using Landsat imagery...”  Read More 
(http://landsat.usgs.gov/documents/LandsatUseage.pdf) 
 

• From the Brazilian Remote Sensing Data Center: 
The Brazilian Ministry of Science and Technology has decided to make available 
for download by interested users, at no cost, the INPE holdings of historical 
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(1973-1983) MSS imagery from Landsats 1, 2 and 3.  
http://www.dgi.inpe.br/html/eng/ 
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25 Years of Landsat 5 – Keeping the Spacecraft Orbiting Correctly 
 
The Landsat missions follow a very strict orbital path to ensure that the same point on 
the globe is collected at the same time every 16 days. The Flight Operations Team 
constantly monitors and tightly controls the satellites’ ground paths and equatorial 
crossing times. To accomplish this, precision timing measurements made during 
communication with the satellites determine their exact orbits.  
 
By knowing where the each satellite is, and then determining where it should be, the 
team can decide which orbital maneuvers are necessary to correct each satellite’s 
position. Two basic maneuvers are delta-Velocity (ΔV) and delta-Inclination (ΔI).   
  
Landsat 5 orbits the Earth at an altitude of 705 km (438 miles). Even with this distance, 
there is still sufficient atmosphere to induce a drag force on the spacecraft, which takes 
energy away from the orbit, reduces the spacecraft’s velocity, lowers its altitude, and, as 
a result, shortens the orbit period. An orbit that is too low or too high will cause the 
ground track of the satellite to drift off course. The orbital path is corrected by firing 
thrusters (located on the back of the spacecraft) that increase the satellite’s velocity, 
raise its orbit, and restore the orbital period (and ground track) to specification. In effect, 
the energy removed by drag is replaced using thrust generated during the ΔV 
maneuver. 
  
Landsat 5’s orbit is also affected by the gravity of the Earth, Moon, and even the Sun. 
These forces influence the satellite’s orbital plane, or inclination. Inclination plays a key 
role in maintaining Landsat’s Sun-synchronous orbit, by controlling the orbit’s 
procession as the Earth orbits the Sun. The ΔI maneuver, while complicated and done 
infrequently because considerable planning and fuel is required, is necessary to help 
Landsat 5 maintain the 10:00 a.m. equatorial crossing time. Once complete, the satellite 
maintains a constant angle between the Sun and the Earth throughout the year. This 
results in consistent illumination of the ground during imaging, which is a key 
requirement in multi-temporal land cover and land use studies. 
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Landsat Free Archive – Commonly Asked Questions 
 
A number of scenes that I have requested to be processed have been rejected, 
and I have been told they cannot be processed. Why is this, and will they ever be 
made available?  
 
In order to generate a Landsat product, a number of processing steps must occur. If any of 
the vital information used for data processing (e.g., definitive ephemeris data) is corrupted or 
lost during data downlink, geometric processing cannot occur.   

 
Because of the large number of data requests in our automated systems at this time, an 
image is removed from the archive when it cannot be processed. As the number of data 
requests decreases, some of the rejected images may be investigated, and if a solution can 
be found, they will be reprocessed and made available to download.   
 
 
I have downloaded an image and received a .tgz file. How do I open it? 
 
Landsat images files are tarred and g-zip compressed. To view the individual band files and 
ancillary data files, the data must be untarred and unzipped using file extraction software 
(e.g., WinZip).
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Landsat Science Team Spotlight - Dr. Darrel Williams,  
NASA Goddard Space Flight Center  

 

 
Figure 1. Dr. Darrel Williams, Landsat Project Scientist, NASA Goddard Space  
Flight Center, Greenbelt, MD. 
 
 
Dr. Darrel Williams has been with NASA at Goddard Space Flight Center since 1975. He 
has served as Assistant Project Scientist for Landsat 4 and Landsat 5, and is the 
current Project Scientist for Landsat 7.  
 
Williams’s primary focus on the Landsat Science Team is to enhance and modify the 
current Long Term Acquisition Plan (LTAP) with co-investigator Dr. Samuel Goward. 
Ensuring successful continuation of a global archive after the launch of the next 
Landsat mission is the objective of their work.  
 
Williams received his PhD in Physical Geography from the University of Maryland, 
College Park in 1989, and attained bachelor’s and master’s degrees in Forest Science 
from Pennsylvania State University in 1973 and 1974, respectively.  
 
Throughout his career Williams has been actively involved in remote sensing research, 
with the majority of his work involved in the development of enhanced techniques for 
assessing forest ecosystems worldwide.  
 
Dr. Williams has received the NASA Medal for Outstanding Leadership (1997), NASA’s 
Exceptional Service Medal (2000), and in 1999, he received the “Aviation Week and 
Space Technology 1999 Laurels Award” for outstanding achievement in the field of 
Space, in recognition of his science leadership role for the highly successful Landsat 7 
mission.   
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Special Recognition – Dr. Thomas Loveland Receives Prestigious Award 
(USGS Press Release: http://www.usgs.gov/newsroom/article.asp?ID=2191&from=rss) 

 
Dr. Thomas Loveland, Senior Scientist at the U.S. 
Geological Survey (USGS) Earth Resources Observation 
and Science (EROS) Center has been named a 2009 
Fellow for the American Society for Remote Sensing 
and Photogrammetry. Annually, one or two 
professionals are awarded the fellowship for 
exceptional service in advancing science and the 
mapping sciences.  
 
Since 1979, Dr. Loveland has pursued research at the 
USGS EROS Center in the field of satellite remote 
sensing to map and monitor land cover and land use. 
During the past three years, he worked to establish the 
USGS-South Dakota State University (SDSU) Geographic 
Information Science (GIS) Center of Excellence where 
he is currently Co-Director. As an adjunct faculty 

member at SDSU, Loveland has taught many courses and advised numerous graduate 
students.  
 
Dr. Loveland was among the first investigators to create continental and global-scale 
land cover data sets derived from remotely sensed imagery. Crossing geographic 
scales again, he presently heads a USGS research team charged with developing a 
contemporary land cover history of the U.S. based on small sample blocks of remotely 
sensed data that are systematically verified in the field.  
 
In addition, Dr. Loveland leads the Landsat Continuity Mission Science Team, a group 
of scientists and engineers responsible for offering advice and recommendations to 
the USGS and NASA on issues critical to the successful launch of the next Landsat 
satellite. A member of the editorial board for the Journal of Land Use Sciences, he 
has served in leadership roles in a number of national and international science 
organizations including the American Society of Photogrammetry and Remote Sensing, 
the U.S. Climate Change Science Program, and the International Geosphere-Biosphere 
Programme. He is a past member of the NASA National Polar-orbiting Operational 
Environmental Satellite System (NPOESS) Preparatory Project science team. He has 
authored or co-authored over 90 scientific papers, delivered at well over 60 national 
and international meetings. He has received career achievement awards from the 
USGS, the Department of the Interior, American Society of Photogrammetry and 
Remote Sensing, and the Association of American Geographers.  
 
Dr. Loveland holds bachelor’s and master’s degrees in Geography from South Dakota 
State University and a PhD in Geography from the University of California-Santa 
Barbara. He and his wife, Cam, reside in Sioux Falls, South Dakota. 
 

Figure 2.  Dr. Thomas Loveland,  
U.S. Geological Survey 
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Tips and Tricks – What can you do with Landsat’s Panchromatic Band? 
 
Landsat’s Panchromatic Band (Band 8) is collected at 15-meter resolution and can be 
used to sharpen a composite 30-meter image.  
 
Pan sharpening is a technique that merges high-resolution panchromatic data with 
medium-resolution multispectral data to create a multispectral image with higher 
resolution features.   
 
This document (http://landsat.usgs.gov/panchromatic_image_sharpening.php) 
provides step-by-step instructions using two software packages to successfully 
perform the image sharpening.   
 
 
 
Meetings & Conferences 
 
The Landsat Technical Working Group (LTWG#18) meeting was held in Maspalomas, 
Spain, February 9 –13, 2009. The meeting was jointly organized by the USGS and NASA 
and was hosted by the European Space Agency (ESA) and Spanish Space Agency 
Instituto Nacional de Técnica Aeroespacial (INTA). Participants from 11 countries, 
including members of the USGS Landsat and Landsat Data Continuity Mission (LDCM) 
Projects, represented 14 international ground stations and discussed a wide range of 
technical topics.  (Read More) 
(http://landsat.usgs.gov/documents/LandsatUseage.pdf 648 KB) 
 
 
 
Association of American Geographers (AAG) 2009 Annual Meeting 
March 22 – 27, 2009 
Las Vegas, NV 
 
“Advancing Geography in Partnership with You” 
 
The Association of American Geographers (AAG) is a scientific and educational society 
founded in 1904. Its 10,000 members share interests in the theory, methods, and 
practice of geography and geographic education.    
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EROS Authors in Recent Publications 
 
 
Chander, G., Markham, B.L., and Helder, D.L., 2009, Summary of current 
radiometric calibration coefficients for Landsat MSS, TM, ETM+, and EO-1 ALI sensors: 
 Remote Sensing of Environment, v. 113, no. 5, p. 893-903.   
http://dx.doi.org/10.1016/j.rse.2009.01.007 
http://landsat.usgs.gov/documents/Landsat_Calibration_Summary_RSE.pdf 
 
Reed, B.C., Budde, M.E., Spencer, P., and Miller, A.E. , in press, Integration of 
MODIS-derived metrics to assess interannual variability in snowpack, lake ice, and 
NDVI in southwest Alaska:  Remote Sensing of Environment.   
http://dx.doi.org/10.1016/j.rse.2008.07.020 
 
Jacques, C.N., Jenks, J.A., and Klaver, R.W., 2009, Seasonal movements and home-
range use by female pronghorns in sagebrush-steppe communities of western South 
Dakota:  Journal of Mammalogy, v. 90, no. 2, p. 433-441.  
http://dx.doi.org/10.1644/07-MAMM-A-395.1 
 
Svancara, L.K., Scott, J.M., Loveland, T.R., and Pidgorna, A.B., In Press, Assessing 
the landscape context and conversion risk of protected areas using satellite data 
products:  Remote Sensing of Environment.   
http://dx.doi.org/10.1016/j.rse.2008.11.015 
 
Napton, D.E., Auch, R.F., Headley, R., and Taylor, J.L., In Press, Land changes and 
their driving forces in the Southeastern United States:  Regional Environmental 
Change, p. 1-17. 
http://www.springerlink.com/content/x2k502355w7879u8/fulltext.pdf 
 
United Nations Environment Programme, 2009, Kenya–atlas of our changing 
environment: Nairobi, Kenya, United Nations Environment Programme, 374 p. 
http://www.unep.org/dewa/africa/kenyaatlas/ 
 
Xian, G., Homer, C.G., and Fry, J.A., In Press, Updating the 2001 National Land 
Cover Database land cover classification to 2006 by using Landsat imagery change 
detection methods: Remote Sensing of Environment. 
http://dx.doi.org/10.1016/j.rse.2009.02.004 
 
Huang, C., Goward, S.N., Schleeweis, K., Thomas, N., Masek, J.G., and Zhu, Z., In 
Press, Dynamics of national forests assessed using the Landsat record–case studies in 
eastern United States: Remote Sensing of Environment.  
http://dx.doi.org/10.1016/j.rse.2008.06.016 
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Landsat Images of Interest - Coal Fly Ash Slurry Spill  
 
Tennessee Valley Authority Kingston Fossil Plant   
Landsat 5 TM:  November 20, 2008 (http://landsat.usgs.gov/images/about/LT5_19-
35_11-20-08_cropped.tif  26.0 MB) and December 22, 2008 
(http://landsat.usgs.gov/images/about/LT5_19-35_12-22-08_cropped.tif  25.7 MB)  
On Monday, December 22, a dike at a containment area failed at the Kingston Fossil Plant, 
releasing approximately 5.4 million cubic yards of coal fly ash. The slurry mix of ash and 
water spread over a half square mile adjacent to the plant. 
 
These Landsat 5 Thematic Mapper images, acquired November 20 and December 22, 2008, 
give a view of the area from space.  The changes in the color of the water indicate the 
location of the sediment.  
 
Recovery and cleanup efforts continue at the plant, which is located on the Emory River 
portion of the Watts Bar Reservoir in eastern Tennessee.  
 

 
Figure 3.  Landsat 5 TM Image acquired  
     November 20, 2008 
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Figure 4. Landsat 5 TM image acquired  

 December 22, 2008 
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25 Years of Landsat 5 – A Remarkable Satellite, A Unique Legacy 
On March 1, 1984, Landsat 5 headed into space with an expected life span of three years. No one could have foreseen that 
this fifth satellite in the Earth-observing Landsat program would far exceed that expectation.  For a quarter century, the 
Thematic Mapper (TM) sensor aboard Landsat 5 has captured images of Earth’s changing surface and has amassed a 
legacy of Earth observation unmatched by any other satellite of its kind.  
 

 Keeping a Satellite Functioning for 25 Years…What Could Possibly Go Wrong?     
Since its launch in 1984, a number of component failures and other malfunctions have beset Landsat 5 and   

challenged the knowledge of the staff working to fix the 1980s technology. Each time, the system has come back to life to 
continue as a necessary and important asset to the USGS Landsat program. 

 
 

Figure 1: Landsat 5 Components 
 
Landsat 5 celebration poster (.pdf)  
 
 
 
 



Page 2 of 8   March 2009 

Landsat Free Archive Update – Stats and Interesting Items 
 

 
Figure 2: Landsat Standard L1T Downloads Through March 3, 2009 
 
 
 

 
Figure 3: WRS-2 Standard L1T Downloads Through March 3, 2009 
     



Page 3 of 8   March 2009 

Landsat Science Team Spotlight – Dr. Warren Cohen, U.S. Forest Service 
 

 
Figure 4:  Dr. Warren Cohen 
 
Dr. Warren Cohen brings over 25 years of remote sensing experience to the Landsat Science Team.  He is a research 
forester for the U.S. Forest Service and is the Director of the Laboratory for Applications of Remote Sensing in Ecology 
(LARSE), located on the campus of Oregon State University in Corvallis, Oregon.  
 
Cohen’s research includes translating remotely sensed data into useful ecological information for process modeling and 
resource management applications. Primary applications include disturbance ecology, succession, inventory and 
monitoring, and carbon dynamics. He is actively engaged in exploiting newer sensor data, such as lidar, and in integrating 
data from multiple sensors with field data for effective use in ecology.  
 
Change detection using historical Landsat data has become a mainstay of Cohen’s research efforts, and he works to 
demonstrate that the rich global archive of data can be exploited to great advantage for change detection across regional 
to continental scales.   
 
Cohen has published over 100 research articles in a variety of peer-reviewed journals. He was the guest editor for a 
special issue of the journal BioScience in 2004 that focused on remote sensing in ecology and biology. He has been a 
member of the editorial board of the journal Remote Sensing of Environment for the past 10 years.  
 
LARSE Web site: http://www.fsl.orst.edu/larse/ 
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Tips and Tricks – Creating a Gap Mask  
 
Question:    If gap mask files are not provided with the data, can I create my own? 
 
Answer:    Yes. Since pixels with missing data have digital number (DN) values of 0, you can differentiate between valid 
and missing data pixels using a number of different remote sensing software packages. A gap mask can then be created to 
show where valid and missing data pixels are located. 
 
The process used to create a gap mask using ENVI is shown below. (Please note that this does not signify an endorsement 
by the USGS EROS Center; we cannot endorse any specific remote sensing software. Other remote sensing software 
packages may also contain similar functionality.) 
 

• Open ENVI 
• Click File  -> Open External File -> Landsat -> GeoTIFF 
• Select the file for which a gap mask is to be created and click Open 
• From the Available Bands List select the file and click Load Band  
• Within the band display, click Tools -> Color Mapping -> Density Slice... 
• Select the band in the dialog box that is displayed and click OK 
• The Density Slice box will be displayed and show eight defined density slice ranges 
• Click Delete Range  until only two ranges remain (it does not matter which ranges are deleted) 
• Once there are only two ranges displayed, highlight the first range and click Edit Range 
• Set the Range Min and Range Max values at 0 
• Select a color you would like to use to display the missing data pixels and click OK 
• Highlight the second range and click Edit Range 
• Set the Range Min at 1 and the Range Max at 255 
• Select a color you would like to use to display the valid pixels and click OK 
• To view the output, click Apply 
• If you would like to make changes to the colors used, select one of the ranges and click Edit Range 
• To save the output, click File -> Output Ranges to Class Image... 
• Click Choose and navigate to the location where you would like to save the file 
• Name the file and click Open, then click OK 
• The gap mask file will be added to the Available Bands list 
• To view the gap mask and the original image at the same time, open two displays and load the images 
• Within the band display of one of the images, click Tools -> Link -> Geographic Link... 
• Click the arrow buttons next to Display #1 and Display #2 so that the box next to each changes to “On” and then 

click OK 
• The gap mask and original data are now linked 
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 Upcoming Meetings 
 

ASPRS 2009 Annual Conference 
 March 8-13, 2009 – Baltimore, Maryland, USA 
 http://www.asprs.org/ 

 
AAG 2009 Annual Meeting  
 March 22-27, 2009 – Las Vegas, Nevada, USA 

http://www.aag.org/annualmeetings/2009/index.htm 
 
 
 
EROS Authors in Recent Publications 

 
Senay, G.B., 2008, Modeling landscape evapotranspiration by integrating land surface phenology and a water balance 
algorithm: Algorithms, v. 1, no. 2, p. 52-68. 
 
Tan, Z., Tieszen, L.L., Tachie-Obeng, E., Liu, S., and Dieye, A.M., 2009, Historical and simulated ecosystem carbon 
dynamics in Ghana–land use, management, and climate: Biogeosciences, v. 6, no. 1. 
 
Li, M., Huang, C., Zhu, Z., Shi, H., Lu, H., and Peng, S., In Press, Assessing rates of forest change and fragmentation in 
Alabama, USA, using the vegetation change tracker model:  Forest Ecology and Management. 
 
 

LDCM News - Ball Aerospace Completes CDR for Landsat's Operational Land Imager 
 
November 26, 2008 - The Operational Land Imager (OLI) being built by Ball Aerospace & Technologies Corp. for the Landsat 
Data Continuity Mission (LDCM), the eighth in the Landsat satellite series, has successfully passed the Instrument Critical 
Design Review (ICDR).  
 
The ICDR, a four-day process in Boulder, included more than 60 representatives from NASA’s Goddard Space Flight Center 
project office and review team, members of the Landsat Data Continuity Mission (LDCM) Independent Review Board, 
Landsat scientists from the U. S. Geological Survey, and industry participants. The team reviewed OLI systems architecture 
and a detailed analysis of integration and the test approach including validation and calibration.   
 
“We are focused on delivering an advanced instrument to support the government’s continuation of the vital Landsat 
program,” said David L. Taylor, president and CEO of Ball Aerospace. “Successful on-time completion of OLI will further 
complement Ball’s strong legacy in both Earth science and remote-sensing missions.” 
ICDR participants noted Ball’s heritage from similar instruments in congratulating the OLI team for retiring major risks and 
moving well beyond ICDR in most areas.  
 
The OLI instrument provides 15-meter panchromatic and 30-meter multispectral Earth-imaging spatial resolution capability. 
OLI includes a 185-km swath allowing the entire globe to be imaged every 16 days. 
 
(View the Ball Aerospace press release at http://www.ballaerospace.com/page.jsp?page=30&id=314 ) 
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LDCM News – Landsat Science Team Meeting Held January 6-7, 2009 
 

The fifth meeting of the Landsat Science Team was held January 6–8, 2009, in Fort Collins, CO, and was hosted by the 
USDA Forest Service.  
 
In addition to status reports on LDCM development and Landsat 5 and 7 operations, the meeting focused on technical 
issues associated with future Landsat data products and requirements for future missions.  The Team also had the 
opportunity to tour Ball Aerospace facilities in Boulder, CO, and view OLI flight hardware.  
 
Some actions from the meeting included:  
Demonstrate the importance of the USGS no-cost Landsat data archive  
Prioritize the International Cooperator's Global Landsat archive data acquisition  
Define the characteristics of future Landsat missions  
Document L1T product specifications  
 
The meeting agenda and presentation materials can be found on the USGS Landsat Web site: 
http://landsat.usgs.gov/science_LST_Team_Meetings.php. 
 
The next Landsat Science Team meeting will be held June 22–24, 2009, in Rochester, New York.  
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Landsat Images of Interest  
Osaka Bay Area, Japan, 2000 and 2008 
 
These images show the land use change in Japan’s Osaka Bay from 2000 to 2008.  A collective 
population of over 16 million people reside in the cities of Osaka, Kobe, Sakai, and others around the 
Bay.  A number of artificial islands have been created in the Bay.  Expansion of Kansai International 
Airport can be seen in the right-center of the 2008 image. 
 
2000, August 25 - Landsat 7 Enhanced Thematic Mapper Plus (ETM+) Path 110 Row 36 

 
Figure 5:  Osaka Bay, Japan area.  Landsat 7 ETM+ Path 110, Row 36.  Acquired August 25, 2000. 
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Figure 6: Osaka Bay, Japan area.  Landsat 7 ETM+ Path 110, Row 36.  Acquired October 18, 2008. 
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Opening the Landsat Archive 
 
Electronic access to the entire USGS Landsat 7 archive, enabling users to download standard-format 
scenes at no charge, has been an amazing success, with over 225,000 scenes downloaded since October 1, 
2008.  Previously acquired imagery from Landsat 1 through Landsat 5, is also now available for 
download at no charge using the same standard processing format. Processing parameters and other 
details about the products can be found at http://landsat.usgs.gov/products_data_at_no_charge.php. 
Previously offered USGS Landsat products with customer-defined options, including media, are no 
longer available.  
 
Newly acquired Landsat 7 ETM+ SLC-off and Landsat 5 TM images with less than 40 percent cloud 
cover are automatically processed and made available for immediate download. Imagery with greater 
than 40 percent cloud cover can be processed upon request. Once the requested scenes are processed, an 
email notification is sent to the customer with instructions for downloading. These scenes will then 
become accessible to all users. Landsat data can be searched, downloaded, or requested from GloVis or 
EarthExplorer. High demand for this data may result in slow search performance and processing times, 
which typically range from 1-3 days for Landsat 7 ETM+ and some Landsat 5 TM data and 3-4 weeks for 
Landsat 1-5 MSS, Landsat 4 TM and some Landsat 5 TM data. Please contact Customer Service at 
custserv@usgs.gov with any comments or questions. 
 
 
 
 



 

Landsat Science Team Spotlight 
 

 
Figure 1.  Dr. Eileen Helmer 
 
Dr. Eileen Helmer has been a scientist with the International Institute of Tropical Forestry (IITF) since 
1999.  The Institute (a research laboratory within the USDA Forest Service) is located in Río Piedras, 
Puerto Rico.  
 
Helmer and collaborators develop methods for using a series of Landsat image mosaics to monitor 
forest ecosystems and land-cover change in persistently cloudy tropical landscapes, integrating 
socioeconomic and biophysical data to reveal what factors drive forest recovery and forest clearing for 
urbanization. They also study how landscape structure influences species diversity and structure of 
recovering forests.   
 
Selected Publications of Helmer or Collaborators 
 
Helmer, E. H.; Brandeis, T. J.; Lugo, A. E.; Kennaway, T.. 2008. Factors influencing spatial pattern in 
tropical forest clearance and stand age: Implications for carbon storage and species diversity.  Journal 
of Geophysical Research 113:G02S04. http://www.treesearch.fs.fed.us/pubs/29987 
 
Helmer, E.H., Kennaway, T.A., Pedreros, D.H., Clark, M.L., Tieszen, L.L., Ruzycki, T.S., Marcano, 
H., Schill, S.R., Carrington, C.M.S. 2008. Distributions of land cover and forest formations for St. 
Kitts, Nevis, St. Eustatius, Grenada and Barbados from satellite imagery. Caribbean Journal of Science 
44(2):175-198. http://www.caribjsci.org/ 
 
Helmer, E. H., M. A. Lefsky, and D. A. Roberts. Biomass accumulation rates in secondary forests of 
lowland Amazonia from space borne lidar and time series of satellite imagery. (Manuscript submitted 
in May 2008). 
 
Ruefenacht, B., M.V. Finco, M.D. Nelson, R. Czaplewski, E.H. Helmer, J.A. Blackard, G.R. Holden, 
A.J. Lister, D. Salajanu, D. Weyermann, K. Winterberger. 2008 or 2009.  Conterminous US and Alaska 
forest type mapping using forest inventory and analysis data.  Photogrammetric Engineering and Remote 
Sensing:  In Press. 
 



 

Helmer, E. H. and B. Ruefenacht. 2007. A comparison of radiometric normalization methods when 
filling cloud gaps in Landsat imagery. Canadian Journal of Remote Sensing 42(3):325-340. 
http://www.treesearch.fs.fed.us/pubs/30282 
 
Kennaway, T. and Helmer, E. H. 2007. The Forest Types and Ages Cleared for Land Development in 
Puerto Rico. GIScience & Remote Sensing 44(4):356–382. http://www.treesearch.fs.fed.us/pubs/30000 
 
Brandeis, T. J., Helmer, Eileen H.; Oswalt, Sonja N.  2007.  The status of Puerto Rico's forests, 
2003  Resour. Bull. SRS-119. Asheville, NC: U.S. Department of Agriculture Forest Service, Southern 
Research Station. 72 p. http://www.treesearch.fs.fed.us/pubs/28823 



 

 
 
The 17th William T. Pecora Memorial  
Remote Sensing Symposium 
 
The Future of Land Imaging - Going Operational  
November 16-20, 2008 
Denver, Colorado 
 
The Pecora Conference series was established by the USGS and NASA in the 1970s as a means of 
sharing ideas and experiences resulting from the use of remotely sensed data. The objectives of the 
Pecora Conferences are: 

1) To foster the exchange of scientific information and results derived from the application of remotely 
sensed data; and 

2) To provide a forum for discussing ideas, policies, and strategies on land remote sensing.   
 
With an eye toward the future, the theme of Pecora 17 is "Future of Land Imaging…going operational." 
The conference offered a program on applications of satellite and other remotely sensed data to study, 
monitor, and manage the Earth's land surface, as well as technologies to improve satellite data analyses, 
quality, access and preservation. Given the recent release of an Office of Science and Technology Policy 
report recommending the United States maintain a core operational capability for land imagery through 
the creation of a U.S. National Land Imaging Program, a special focus of Pecora 17 was on the 
challenges of migrating satellite programs from research missions to operational capabilities. 
 
http://www.asprs.org/pecora17/ 



 

 
Landsat Ground Station Operators Working Group (LGSOWG) Meeting 
 

The Landsat Ground Station Operators Working Group (LGSOWG-37) meeting was organized by the U.S. 
Geological Survey (USGS) and hosted by the Center for Earth Observation and Digital Earth (CEODE), Chinese 
Academy of Sciences in Shanghai, China, September 15 – 19, 2008.    
 
Participants from 11 countries, including representatives of 17 international ground stations, members of the USGS 
Landsat and Landsat Data Continuity Mission (LDCM) Projects, and NASA staff, discussed details regarding 
Landsats 5 and 7 mission status, no-cost Landsat product distribution, the Landsat Global Archive Consolidation 
initiative, programmatic issues and future plans.   
 
LDCM sensor and spacecraft development was the primary topic of discussion, supported by presentations on 
project and ground system status; downlink agreement concepts; ground system and downlink overview; data 
archive, production and distribution; and Landsat Science Team activities.   
 
International Cooperators reported on the status of their systems, and provided information regarding the business 
model and organizational structure of their stations.  They also addressed future satellite mission and ground system 
plans of their agencies:    
 

Japan:  Presented data distribution status for the Advanced Land Observation Satellite (ALOS), as well as a 
report from JAXA, the Japanese Space Agency, on current and future earth observation missions.   
 
 Germany:  Detailed several recent and future programs, including TerraSAR-X (launched June 2007), 
TanDEM-X (to be launched end of 2009), EnMap (to be launched in 2011), and RapidEye (launched August 29, 
2008).   
 

Brazil: Presented the status of the China-Brazil Earth Resources Satellite (CBERS) 2B, launched September 
19, 2007.   
 

Argentina: Reported the status of the Satélite de Aplicaciones Científicas-D (SAC-D) spacecraft, scheduled 
for launch in May 2010.  
 

Europe:  The European Space Agency (ESA) briefed the group on the many ESA programs in progress, 
including the Global Monitoring for Environment and Security (GMES) programs.   
 
Given the Global Earth Observation (GEO) activities in which most countries participate, sharing information about 
ongoing and future earth imaging programs is of increasing importance.   



 

 
LGSOWG-37 participants in Shanghai.  Photo credit:  CEODE 



 

50,000 Orbits and Counting 
 
The Landsat 7 satellite established a milestone by  making its 50,000 orbits around the Earth on Monday, 
September 8, 2008.  That’s more than 1.2 billion miles traveled.  Launched on April 15, 1999,  Landsat 7 
was designed for a 5 year mission-life, but exceeded expectations.   
 
The image below was acquired by Landsat 7 and shows a portion of the Yalu River, which separates the 
cities of Dandong, China, (top, center portion of the image) to the left, and Sinuiju, North Korea, to the 
right. 
 
The river is 790 km (491 mi.) in length and forms the northern boundary between North Korea and the 
Jilin and Liaoning Provinces in north China.  Dandong (located on the left bank of the Yalu, top center) 
has a population of 2.4 million and is the largest border city in China.  With a much smaller population of  
200,000 (1981 est.), Sinuiju grew because of the lumber industry, which uses the river to transport logs 
from inland forests. 

 
Figure 2.  Landsat 7 image of the Yalu River and the Korea Bay. 



 

New NASA Grant to Facilitate Landsat Usability 
Story courtesy of NASA (http://landsat.gsfc.nasa.gov/news/news-archive/news_0158.html) 
 
Dr. David Roy of South Dakota State University, Geographic Information Science Center of Excellence 
(GIScCE), is the recipient of a $3.29M, 5-year grant funded by NASA’s Making Earth System Data 
Records for Use in Research Environments (MEaSUREs) program.   
 
Landsat data will be fused with MODIS land products to systematically generate “seamless” consistent 
mosaicked Landsat ETM+ data sets with per-pixel quality assessment information and derived land cover 
characterization at monthly and longer time periods.  The mosaic products will be generated for the 
conterminous USA and Alaska for a 7 year period, and made freely available to the user community in 
near-real time. 
 
The project is a collaboration with the U.S. Geological Survey’s Center (USGS) for Earth Resources 
Observations and Science (EROS). The USGS Center is the repository for satellite images taken from the 
Landsat series of satellites which since 1972 has been providing the longest dedicated land remote 
sensing data record of the Earth.  Dr. Tom Loveland, who is the USGS Landsat Science Team Leader, 
said, “This project will provide the USGS with a state-of-the-art strategy for creating the land monitoring 
data sets needed by the nation's resource managers and an exciting opportunity for evaluating the next 
generation of Landsat processing and delivery systems. The project is timely because as of this year, 
Landsat images became available free of charge.” 
 
The grant supports Roy’s innovative approach for filling the information gaps that commonly exist in 
Landsat data.  These “gaps” result from both cloud-cover—which on global average obscures 35% of 
Landsat data— and the triangular data voids created by the May 2003 failure of the Landsat-7’s Scan 
Line Corrector.  Roy’s approach uses 500-meter data from the MODIS sensor (specifically, the 16-day 
MODIS BRDF/Albedo product) and existing gap-free Landsat data to predict Landsat reflectance for a 
given date. This method works, on a per-pixel basis, by modulating the Landsat reflectance of the known 
date data by a value that represents the relationship between MODIS reflectance on the prediction and 
known dates—while taking into consideration the Landsat sensor-sun view angle geometry. 
  
Scientists will spend the first half of the five-year period developing a prototype at South Dakota State 
University. Then they'll move the system to the USGS and put it into operation.  
 
Dr. Tom Loveland and Dr. Matthew Hansen are co-investigators on the project. Dr. Hansen said, “This 
project has the potential to fundamentally change the way satellite data are accessed and used.  Our 
experience in processing and characterizing Landsat imagery will enhance the data's utility for a whole 
range of users. This is a very exciting project.”  



 

Did You Know? From the Landsat Legacy Project 
- http://library01.gsfc.nasa.gov/landsat/ 
 
Landsat satellite imagery has been used by Alaska to aid navigation in Cook Inlet 
 

 
Figure 3.  Cook Inlet, Alaska and the Cook Inlet Watershed area 
 
Cook Inlet is 192 miles long and is one of the most productive fisheries in Alaska.  Along with five 
species of salmon, several other species of fish make the inlet home.  Nearly two thirds of Alaska’s 
population (400,000 people) lives in the watershed area. 
 
The Cook Inlet watershed covers 47,000 square miles of south-central Alaska.  Melting snow and ice 
from mount McKinley, the Chugach Mountains and the Aleutian Range drains into the Susitna, 
Matanuska and the Kenai rivers, which feed the inlet. 



 

EROS Authors in Recent Publications 
Landsat data in peer-reviewed, published articles. 
 
Development of Landsat-5 thematic mapper internal calibrator gain and offset table 
 Proceedings of SPIE (Society of Photo-Optical Instrumentation Engineers) Vol. 7081: Bellingham, 
WA, SPIE, p. Article 708115.  
 
Barsi, J.A., Chander, G., Micijevic, E., Markham, B.L., and Haque, Md.O., 2008, , in Butler, J.J., and 
Xiong, J., eds., Earth Observing Systems XIII, San Diego, CA, Aug. 11, 2008-Aug. 13, 2008,  
 
http://spiedigitallibrary.aip.org/getpdf/servlet/GetPDFServlet?filetype=pdf&id=PSISDG0070810000017
08115000001&idtype=cvips 
 
 
L5 TM radiometric recalibration procedure using the internal calibration trends from the NLAPS 
trending database 
 Proceedings of SPIE Vol. 7081: Bellingham, WA, SPIE, p. Article 708114.  
 
Chander, G., Haque, Md.O., Micijevic, E., and Barsi, J.A., 2008, , in Butler, J.J., and Xiong, J., eds., 
Earth Observing Systems XIII, San Diego, CA, Aug. 11, 2008-Aug. 13, 2008,  
 
http://spiedigitallibrary.aip.org/getpdf/servlet/GetPDFServlet?filetype=pdf&id=PSISDG0070810000017
08114000001&idtype=cvips 
 
 
Tips and Tricks 
 

  RSS Feeds on the Landsat webpage 
 
Clicking  on any of the orange icons on the Landsat home page will take you to the RSS (Really Simple 
Syndication) feeds page.  After you have subscribed you will be alerted when new content is added the 
next time you visit the page.  It’s a great way to stay up-to-date with changes to the site.  
  
Subscribing to a feed is simple – after you subscribe, the Feed Properties dialog box will appear.  You 
can then select your schedule parameters for when your browser checks the web site for new content.   
 
To view your subscribed RSS feeds, click on the Favorites button in Internet Explorer and click on the 
RSS icon.  If you are using Firefox as your browser click on the Bookmarks option then click on the 
folder with the RSS icon.  The list of subscribed feeds will show up in the drop down menu.  To 
unsubscribe to a feed delete the link in your Favorites or Bookmarks. . 
 
The Landsat website currently has 5 RSS feeds:  

• Headlines 
• Landsat Image Gallery 
• Recent terrain-corrected images 
• The latest Landsat 7 scenes 
• Landsat Updates 


